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1 INTRODUCTION

This document is deigned to assist people who are using SureTrak, P3, Primavera Enterprise

or Microsoft Project to learn the basics of Powerproject to create an unresourced schedule.

1.1 WBS Definition

» SureTrak and P3 have the following functions to generate project breakdown

structures:

o

o

o

Activity Codes,

Activity ID Codes,

One Hierarchal WBS, where a WBS Node may not be assigned resources,
costs or notes and costs are calculated from the addition of the activity costs.
SureTrak also supports Outlining in the same way as Microsoft Project,
where a summary task may be assigned resources, costs and notes, but the

durations are adopted from the summary tasks.

» The project breakdown structure for SureTrak and P3 projects is usually created

using Activity Codes and Activity ID Codes for larger projects. There is a less

frequent use of WBS and Outlining

» Users of Microsoft Project predominately use Outlining but there are options to use

hierarchical Outline Codes or Customizable date fields and the Grouping facility to

produce an alternate view of tasks.

» Primavera Enterprise predominately uses a WBS function as the main method of

displaying the project breakdown structure but also has user definable hierarchical

coding structures available for organising the project activities.

» Powerproject uses the following functions to :

o

Typically uses “Summarising” (the same as Outlining in Microsoft Project) to
generate a hierarchical project break structure. The summary tasks generate
WBS codes in a similar way to Microsoft Project’s WBS Define Codes
function.

It has a unique and predominant function that allows multiple tasks to be
displayed on one line. These tasks are held one summary task. There is not a
similar function in SureTrak of Microsoft Project.

It also has Codes Libraries and Codes that may be assigned to tasks that are
used to filter, sort, group and colour code the tasks in the bar chart. These
may be used in a similar way to Grouping by Activity Codes in SureTrak and

P3 and Grouping by Custom fields in Microsoft Project.
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o There are no customisable hierarchical codes fields available such as the
Primavera Enterprise WBS or the Microsoft Project Custom Outline codes.

o A hierarchical structure may be synthesised using two or more Code Library
fields.

1.2 Constraints, ASAP & ALAP

The option of ALAP is treated like Primavera software, as Zero Free Float and consumes
Free Float and only delays the task that has been constrained. In Microsoft Project a ALAP
constraint consumes Total Float and delays all successor tasks with Total Float, which is

often not very useful.

1.3 Bars & Tasks

A bar and corresponding task may have different descriptions and different IDs.

A bar also has the capability of storing and displaying multiple tasks on one line. In this
situation:
» The bar has a unique name, and

» Each task belonging to the bar may have its own unique name.

1.4 User Interface

Powerproject has an “Explorer” type user interface for editing calendars, resources, codes etc
which makes it very simple to access and edit project data.

» Primavera software and Microsoft Project accesses this data using forms.

» Powerproject uses an Explorer type function titled the Library Explorer, the Library
is opened by clicking on the W icon on the Standard Toolbar. Project data such as
Calendars and Resources may be dragged onto tasks making this product simple to
use, but different to other products mentioned in this paper.

Therefore there is one place where all information may be accesses and this reduces the time

required to open and close forms as with Primavera software and Microsoft Project.
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The picture below displays the Library Explorer:

» Asta Powerproject - [Admin - Library Explorer - Float Calculatio... (= |[5]X]
© File Edit Wiew Insert Format Tools Hierarchy Window Help NERS
bDEd oW ([ LBRD(9-C- [ XEER (X b ~ @
Y| a2 w |8 =51 -2 2| e ETaske o
[ Calendar ~Eh-O- XYM

4ll Objects Contents of 'Calendar’

Project Objects 4| Name Object Id | Locked T
Allocation Group (4] 205 7.5 Day et Holiderys (Xmas & Easter) 4521
Arnotation Categary (4] AUS & hr Dey Nat Holidays (Xmas & Easter) 4562
S Calendar (4] Standars! Wk No Holidays 3

=-{] Code Library
Cansumshle Resaurce
Cost And Incorme Rate
[ Cost Cente
Link Categary
Permanent Resource
Progress Period
Resaurce Repart
-7 Tabular Repart =
Exception
Filter
Histogram Repart
Resource Graph Definition
Sort v |4 ﬂ

3 object(s)
- |4 | - o Je =0 || © -

Should there be a Library missing from the Library View then right click in the right hand

side and select Show Libraries... to open the Show Libraries form add the missing ones:

Show Libraries

Auailable types: Shaw these tpes in this order oK |
Histogram Repart Calendar A C |
Link Categary . Code Library — e
Resource Graph Definition Cozt Centre

Permanent R esource

=
=%
(=%
e

ort
Standard ‘Work Progress Period
T able Definition T abular Report
Time Unit Resource Report
“w/ork, Lnit Conzumable Resource
Cost And Income R ate
Exception
Uzer
‘wiork Pattern
Currency Unit
Filter

i€

1.5 Options

There are the following options areas that should be studied:
» Tools, Options... sets the Global Options
» Tools, Bar Chart Defaults... sets the defaults currently open file.
» Tool, Customise allows the display of Toolbars.

1.6 Views, Table and Filters

These functions are very similar to Microsoft Project where a View includes an associated
Table and Filter associated. The menu commands are the same as Microsoft project.

Therefore a Table or Filter may be applied to many Layouts.

Primavera software use Layouts to display data and this where the columns of data to be
displayed and how the activities are Grouped and Sorted within a Group is specified. A

Layout is similar to the combination of a View and Table in Asta and Microsoft Project.

8
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Filters may be created in Asta using a Wizard by selecting View, Filters, More Filters...

and selecting New.

1.7 Terminology

» Token is an attribute assigned to a task and may be displayed as a column of data

such as constraints and dates.

Y

Links are relationships or logic

Y

Relationships are the relationship between detailed tasks and their summary tasks.
» Baselines are copies of complete projects that are copied and set as Baselines. The is

the same as P3 and Primavera Enterprise

1.8 Spell Checker
The MS Word spellchecker is used with this software.

1.9 Undo

There is an unlimited undo which operates after the project has been saved.
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2 CREATING A NEW PROJECT

2.1 Create a Project from a Template

Select File, New to open the select Template to create a new project:

New Project Wizard

asta|powerproject

Select a template file

& = £
Congtruction Housing Australian
Template.pp Template. pp Template.pp
File: location |Untitled.pp Browse...
MNarne |Untitled
Foar |
Start [12/04/2007 | By |
Uzer name |.-’-‘«dmin Pazzwiord |

ok | Cancel ‘

» Select the template, fill the details.
» Use Tools, Options..., File Locations tab to select the default directory to save files.

» Select OK to create the project.

2.2 Create a Template

Open a project, select File, Save As and select the template directory and save. This si the

same as SureTrak and Microsoft Project and it is suggested a project is cleaned up before

saving as a template.

10
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2.3 Customizing the Screen

Toolbars are displayed & hidden using View, Toolbars or right clicking in the Toolbar area,
as in SureTrak, P3 and Microsoft Project. Primavera Enterprise has limited Toolbar

customizing features.

P Asta Powerproject - [Bar Chart View - Option
£ File Editlnsert Format Tools Hierarchy Window Help

DG | & vew |9y E€|X
Table
S E g e g ! CETR— 1
Ogmre s
= B
- ':. l]:.i,.i\‘ + 1 STAGE 1

STAGE 2

Histogram Yiew nary to Sai+| 2
Project Yiew erage | 3 |STAGE 4
|_ Toolbars ¥ | Bar Chart
@ Refresh view FS |[¥ | Formatting
Zoorm.., ¥ | Obiject Edit
WESandy Creel | w

Popup Menus
Traffic Managen

H h 2600 - 3700 San Resource Maodelling
% h 3700 - 4400 Cam | ¥ | Standard

+ Q Eastbound Carriageway
+-2dF STAGE 2

¥

Customise...

The Customise allows users customise Toolbars, in the same way as Microsoft Project.
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3 CALENDARS & TIMESCALE

3.1 Calendar Concepts

Calendar concepts are far better and more developed that the other products and summary

durations (durations displayed in days or weeks) calculate correctly. SureTrak, Primavera

Enterprise and Microsoft Project calculate the summary durations using one parameter and

therefore when projects are assigned calendars that have a different number of hours per day

then some summary durations are incorrect.

>

>

Y

Calendars are saved in a library & may be used for tasks and/or resources. E.g. a
single calendar may be assigned to both a task and a resource.

Each project has a default task calendar, which is assigned to a task when it is
created.

Each Calendar is assigned a Work Pattern which determines the working hours per
day & week for the calendar. A Work Pattern may be assigned to more than one
Calendar.

The task calendar may be changed after the task has been created.

When a different calendar is assigned to a project then all new tasks are assigned the
new calendar as they are created.

Relationships or Logic Links are called links. The term Relationships is reserved for
the relationship between Summary and Detailed tasks in Power Project. The link
between two activities in P3, SureTrak and Microsoft Project has a duration and in
P3 and SureTrak is calculated on the predecessor calendar and in Microsoft Project
2002 to 2007 on the successor calendar. In Power Project both the predecessor and
successor may have a lead or lag from the start or finish of the task and the link joins
these two points. Therefore there is no calendar on a link and Asta provides a unique
and superior solution than other products.

Exceptions are non work time and may be named, e.g. Weekends or Holidays.
Exceptions may be user defined such as RDOs. Exceptions may be used in the
timescale display covered next.

Calendars may be “Folded” to hide Non Work time on the Bar Chart. This again is a
unique feature of Asta.

Three Time Zones are available and each may have a different horizontal scales. This

1s similar to the SureTrak Zoned timescale.

12
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3.2 Creating and Editing Calendars

3.2.1 Creating a New Calendar

» Open the Library Explorer by:
o Clicking on the @ icon on the Standard Toolbar, or
o Selecting View, View, Library Explorer.
» A new window has been opened, like Primavera Enterprise and open windows may

be accessed from the Window menu or using Ctl Tab to scroll through open
windows.

Select the Calendar Object (Folder)
Rights click in the right hand pane and select New Calendar & run the wizard.
» The non work times may be set on the Assign Exceptions form in a similar way to

SureTrak but different types of Non Working Types are available:

YV VY

Assign exceptions ’
Mow set other working and non waorking time such as holidays and overtime,

wWorking/Mon Warking Type

Warking
Holiday
COreertime

Weekend

< Back | Mext » | | LCancel | Help |

» To Close the Library click on the Close Icon at the Top Right Hand side of the
window.

13
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3.2.2 Editing a Calendar
To Edit a Calendar:
» Double Click in Library Explorer on the calendar to be edited,
» Click on the Calendar tab
» Select the days to become non work using Ctl Click, Shift Click or selecting a Day
on the Left Hand Side
» Right click on a select day, from the menu select Add Exception and select the
Exception type.

Calendar Properties for YIC Calendar (to 07)

Calendar l Details] Wtk Pattern Assignments] E reeption Assignments]

2008 2009 2010 D Mo working hours . 2h or more . Selected dates

January February
26 2 9 16 23

Wiew working hours. ..

Assign work patkern 3 [inf17]zafa1] [ 7]1a]a1]zs]

Assign exception W November December

hubary Holiday 9 26
Tue Delete exception assignment 4 Mon Working 0
e Delete all exception assignments Owertime
Thu RDO
Fri Copy exceptions to.., Weekend
sat |4

Te—r—— pere—r—r———— )
sun |5 [12]1a]zs] BT C e IBEEEIROEEE

Add E=ception... | Delete Exception | é Frint...
A Less << | Close |

» Select the start and finish time for every selected date or select All day exception:

¥t Add Exception to 6 day we... EE|

Exception Dates: Mon 26/02/2007 P\
Exception type: |@ ﬂ

Start time: 00:00 -

[~ Al day exception

Erd tirne: 00:30 -

Add Cancel

14
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3.2.3 Summary Duration Calculation

SureTrak, Primavera Enterprise and Microsoft Project all have one factor to display
summary durations for displaying durations in days or weeks or months. Thus a schedule
with multiple calendars that have a different number of working hours per day will always

display summary durations incorrectly if the calendar is not matched to the correct factor.

In Power Project each calendar has its own factors and therefore all summary durations will
be displayed correctly if the calendar is set up correctly. Right click on the Calendar in the
Library View to open the Work Pattern Properties form:

Work Pattern Properties for 8hr-... El[‘Zl

Details  Time Urits ]

Time Lnit | Owerride Definition |
Second 1=
hinute Gz
Hour BOmin
Half Davy [ah
Day [ah
ek [7d
Marth [ 2 50
Quarter |3m
Year [y

»

3.2.4 Editing a Work Pattern

Select the Work Pattern that has been assigned to a calendar in the Library Explorer to edit
the working hours for each day and edit the working hours per day.

- Wiark Pattern ~ | Exception | Start Time | End Time
+-[7 & Day Warking Week I monwiorking 0000 A 2000 A
—=-F3 Standard I wigekend 00 &b 12:45 PM
! Mon Wwiorking 12045 P 1:45 P

ﬁ Monday ! Wigekend 1:45 P 330 Pt

ﬁ Tuesday‘ ! Mon Working  5:30 P 0:00 A

£3 wWednesday

£3 Thursday =

Friday -

15
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3.2.5 Setting the Default Task Calendar
Select Tools, Bar Chart Defaults..., Task tab and select the default calendar:

Bar Chart Defaults Properties for paul ['Xl

Bar  Task ] Link ]Annotations]

Defaults for task

Property | Walue -
- Dates -
Duration [50
Calendar |5 day week, Hmas & Easter only
Uze Parent Calendar -
- Constraints -
Placement =
Levelling Priority |D
Can Be Delayed Ird
- Milestone -
Milestone Type |§tart
Milzztone Placement ASAP
- Allnratinne . | ﬂ

Task Defaults Profiles

Save hs. .

Cloge
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4 ADDING ACTIVITIES

Each task has:
» A line number which is renumbered as tasks are inserted.
» Task ID Number which is unique to the task and is generated based on the unique
Task ID Rules.

Activities may be created by copying and pasting from other products.

4.1 Task ID Rules
Select Tools, Unique Task ID Numbering to open the Unique Task ID Numbering form:

Unique Task ID Numbering @E}

Dretails ]
Definition
Prefix code

Starting walue m
Miriirnurn waidth 4 El:
Humbering
Increment walue m Sub-increment value m
[v Emnable sub-incrementing on inzerted Tasks

Unigueness
Tazk |Dg are * Urigue
" Urigue within Sumrary ¢ Expanded T ask
" Mat unique

ak. | Cancel

Most headings are self explanatory:
» The Prefix code are characters placed in front of a code.
» Minimum width prefixes the ID Number with zeros
» Sub-increment is used to number tasks assigned to one bar or to create an inserted

task number so one does not have to renumber inserted task as with SureTrak.

17
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4.2 Add Tasks
The Task and the Bar have a description and a Task may be added without a Bar and a Bar

without a description, thus making it a heading, but not a summary task, this is a very useful

function to subdivide a long list of tasks without creating a new level of summary tasks.

4.2.1 Methods of adding tasks:

There are two main options
» Type in the name & assign a duration, it will be scheduled ASAP,
» Draw a task on the Gantt Chart by dragging with the mouse in the Bar chart area
where the task is required, then type in the name.
When a task is added by drawing, the task remains in the place as the scheduling only takes

place when the schedule is rescheduled.

4.2.2 Task Placement

When dragging a bars it may be made to snap to a days, week etc by selecting the Snapping
Time Unit drop down box in the Bar Chart tool bar.

P Asta Powerproject - [Bar Chart View - Wilson

{» File Edit Yiew Insert Format Tools Hierarchy Window Help
NEH S0 0B | 9 -0 LAE
2 E E‘z E‘z q% I& 8 Elapsed Month: SR =]
- o Miilzon International Bid
- (B Rost chart Line ] - ne
—-a3F 0zBuild Bid
Rezaarch Haurs
Estimate Half Days
+ 1
Fropuosal Days
= m Cost Centres Weeks
T Detault + 2 |Elapsed Months
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4.2.3 Task on the Same Line

A second task may be added on a line by dragging a second task on the same line.

The method that these tasks on one line are scheduled is selected in the Tools, Schedule,

Options tab under the Tasks with no links section:
Reschedule

Tasks with no links Tasks with only outgoing links
" Leave as drawn within constraints

" Leave as drawn within constraints
% Move to ASAP/ALAP position

i o

Compatibility Options

[ Marmal eritical behaviour Iv Move part completed links

[ Finish on or before flags are soft I~ Truncate float within chart boundaries
Ignore link categories ™ Belink aound completed tasks
[]Default Straighten progress line to periad
[CJimportant Progress entry period ﬂ
[ IMarmal

[JResource [ Only move forward to make straight

Cancel

NOTE: These tasks have an inherited Finish to Start relationship, note the task below is
ignoring the -5 day Lag but acknowledging the 5d Lead

2009
July |

The bar and tasks may have different names, the defaults are set in Tools, Options, Edit tab:
» They may be named in the table, or
» By selecting the whole bar or task by clicking on the line number,
» Right clicking and selecting the Bar properties and
» Select the Bar or Task tab as appropriate.

19
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4.2.4 Assign Task Calendars
A calendar may be dragged to assign it to a task:
» Open the Project view using View, Project View, or click on the icon and this

will open on the Left hand Side the Project Pane where schedule resources may be
accessed from.

» Select one or more tasks, then

» From the Project window expand the Calendars and drag a calendar on to the task

bar.

®? Asta Powerproject - [Bar Chart View - Wilson Internationa
OEMe Edit Yiew Ingert Format Tools Hierarchy Window Help

DEH 299 (L0E|9-0- VAR X

@Y E=2H|8 i Days - | More Views... B - Al
=I-g) Wilson Intemational Bid 2008
= @ Root chart Name December January
= 5 ozBuil Big 1 15 @9 [z
Research A2 4§ @
Feimate OzBuild Bid a
Proposal -}
=1t Cost Cantres
T vesut Research

=5} Code Libraries
{5 Default Library

=[] calendars
G e U QUL

Received

Bid Strategy

Default

Technical Feasibility Stuc

Bid Request Documents b
——
L

Standard
B Progress Perinds
Sy pefautt

Estimate . =
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4.2.5 Columns

» Add a column by right clicking on the header where a new column is required and

select Ad

d Blank Column.

» To display for example the Calendar column right clicking on the blank column (or

any other existing column should you wish to change the contents) and select Token,

then select the required data filed:

E
[E Paste

Paste Yalues

Cirl+C
Clri+y

Rermove This Column
Add Blank Colurnn
Tahle Definition. ..
Token

Alt+F3

Format Cells...
Default Tahle Fonts. ..

Best Eit

Select Column Heading
07Aug0?
O7Aug0T
O7Aug07
1380007
1380007
2040007
090ct07
080cta7?
28.Jan08
28Jan08

A0 0D

2007
B October Movermber
122 29 5 12 19 26
17 018 19 20 121 | 22 | 23
22/04f2008 |3 [
8/04/2008 |V 1
1312007
11 2r2007 i
ai0zrz008 )
4i03rz008 |
8/0472008 i '
9/07/2008 | [
SNTINNS i '
Identification [ I
petal e
Progress v actual start
Earned value 4
Constraints 4 Cumftive duration
Cost or Income 4 Duration
Float L4 Duration variance
Resource 4 Elapsed duration
Allocations 4 End
Codes 4 End variance
Logic 4 Resume
Defnand Resourcing  » Start
Miscellanecus 4 Start variance
Project information  » Suspend
User Figlds 4 l
User Defined Tables I

4.2.6 Create Milestones

To create a Milestone:

» Enter a zero duration to make a task a Start Mile Stone, or
» Right click on the task in the Bar chart and select Make Into and select the milestone

type:

Make jto |

StartMilestone  |& Link Flgi/To...
End Milestone Copy Properties to Defaults
Summary
Expanded ﬁ_.:; Assignment biew
Hammaock ) .
Buffer Task assign
Interruptible

ad 2ol T Aams I

1d| 28102008 |1

ow | 25(022007 \E

2w BI0E/2007 1?

Tw| 131092007 1]

Zw| 270972007 1] X

e ez m Y Properties..

» Right Click on the Bar Chart and select insert Milestone.

21
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S CREATING AND ASSIGNING SUMMARY TASKS

5.1 Summary Tasks may be Indented like MSP

Summary Tasks may be added to created a project breakdown structure:
» Select the tasks (ensure you highlight the whole task not just a cell) to be summarised
by highlighting the bar number
» From the Bar Chart toolbar click on the Summarise button and a new blank
Summary task will be created.

» Type in the name.

- o Wiilzon International Bid " 2005 |
= @ Raot chart L@ Marme DAV e | December | January
- A% ozBuild Bid Efiort 11 8 15 _ 22 29 g iz 19
R 1 2 3 4 5 B 7 | 8
ezaarch :
Estimate + 1 Research 1w 4d p—
Froposal
b m Cost Centres + 2 Bid Reguest Documents Received
+-fZ} Code Libraries + 3 Bid Strategy 1d
+ ”! Calendars
5 Frogress Periods + 4 Technical Feasibility Study 1w 3d _—c
+ 5 Estimate 3w 2d ]
+ B Installation Reguirements 4d 1 —
+ 7 Supplier Component Bids 3d ‘;
+ 8 | ProjectScheduls ad 8 — g
+ 9 Technical Specification 1w 4d =] =‘=|
+ 10 Component Bids Costs 2d mh |
+ 11 |Proposal 2w \\JJ
+ 12 | DraftBid Docurnent ad 1

» Indent and Outdent z= icons may only be used to indent and outdent tasks after
a Summary task has been created in the same way as Microsoft Project and SureTrak,
but ensure the whole task or the bars is selected. This function is not available when
a cell is selected.

» When the Project View is selected then the summary tasks are displayed as a
hierarchical structure in the window. When one or more nodes are selected then only
the tasks associated with the nodes are displayed. This is like filtering to display only

selected summary tasks, a very powerful feature.

=] 0 Wilzon International Bid 2008 |
= @ Root chart - | Ciecember | January
Line Mame
--dF OzBuild Bid L 8 45 22 28 3 qjz 18 2
E— L T T T N B N LA B B
Estimate + 1 | Bid Request Documents Received |
Froposal ; .
+ m Cost Centres + 2 |Hid Strategy
#I-fi Code Libraries +| 3 Technical Feasibility Study ' *
+ EI Calendars :
5 Progress Periads + 4 Draft Bid Document f
+ 8 |Reviewed Draft Bid Document
+ B | Design Validation
+ 7 |Revised Bid Document
+| 8 Component Packages Megotiated
+ 9 | Bid Dacument Final
+ 10 | Bid Submitted
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5.2 Creating a Project (Sub Project)

Creating a Project is like creating a subproject in SureTrak or P3 and should be used for a
programme of projects.
» Make a summary bar for the activities that are required as a Project,
» Display the Project View using View, Project View, or clicking on the Project View
icon,
» Select the summary bar in the project View
» Right click and select Is a Project

5.3 Expanded Task

This allows the addition of tasks under an Expanded task and these tasks are not displayed in
the main view. The details are only displayed when the Expanded task is opened by double
clicking. This Expanded task becomes a subnet and may form part of the critical path. There
is no equivalent in the other products. It enables the development develop detailed tasks for
one task but not display the detail in the main schedule.

» Create a new bar

» Select, Right Click & select Make Into Expanded

» Display the Project View using View, Project View, or clicking on the Project View

icon,
» Select the expanded task.

5.4 Multiple Tasks on One Line

This is used to save on vertical real-estate and allows multiple tasks on one line and would
typically be a number of similar or repeating tasks. Each task could be an expanded tasks.
» Drag and draw the multiple tasks on one line in the bar chart,
» Expand and add description, duration and logic etc.
» When expanded the detailed tasks have unique Name and when rolled up the
summarised task has its own description that is hidden when expanded.
» Before Expanding the Task

+ 13 :‘Igg-ﬁn- Summary oftask on one line 2i0a;

» After Expanding the Task

i | |
| I |
13 100 Summary Task 1 on ane lina 21058f ; : i
14 110 Summary Task 2 on one line 22105 | - : f
18 (120 Summary Task 3 on one line BI0GY | ; m:;
| 1 |
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5.5 Hammock

A Hammock works in a similar way to a WBS activity in P3 & SureTrak and allows the
durations of randomly selected tasks to be summarised but unlike Primavera products it does
not have relationships. To create a Hammock:

» Create a new task, by adding a bar.

» Right click on the bar and select Make Into and select Hammock.
» Select the tasks that are required in the Hammock
» Right click an select Add to Hammock
» The tasks under a Hammock are displayed twice:
2007
Hine | Teskib Hame |.T§‘r}”.|!|2.|6.|.|lhjka.y|.|22.|.|.!|3.|.|11?L|Jr?e|19.|.|..:l.|.
23 130 7 (14 21 28 4 (11 (1B 25 2
+ 1 |10 Summmary 1 20/04/ % :
+ 2 |20 TaskA 0041 h !
+ 3 30 Task B 31051 : - :
« 4 40 TaskcC 15105/ ! - !
+ 5 0 Summary 2 281051 : F—
+ 6 |70 Task 1 zsmsr; ! -
f 7 |80 Task 2 7106/ ; , h
« 8 &0 Task 3 znmaré : : -
« 9 130 Hammuock 3105/ | —
10 |30 Task B 3105;; : s :
1 70 Task 1 28105/ | .

5.6 Buffer Tasks

These are like Critical Chain Buffers and adjust their duration to maintain a Deadline date.
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6 FORMATTING THE DISPLAY

6.1 Timescale Concepts

6.1.1 Exception Display

Powerproject has the ability to hide or display Exceptions (non work time).

The picture below displays all time and the Exceptions are displayed:

2005

2006

Decermnber

January

|18|1‘3|2E||21|22|23|24|25|25|2?|28|29|3D|31| 1,2,3,4,5 6

2

The picture below hides the non work periods, notice Dec 24 to Dec 27 are not displayed:

2005

2006

Decernber

Januar\,r

|
19 20 21 22 23 28 29 30 2 4 5

—
I

6.1.2 Timescale Calendar

The Timescale may be set its own unique calendar, like MSP, and it may display the non

work time (Exceptions) on the Gantt chart:

2005

2006

Decermber

January

|1El|19|20|21|22|23|24|25|2E\|2?|2EI|29|SD|31| 1,234,536

IS e E—

e eem W
% | |
25

Eastwood Harris



CONVERTING TO ASTA POWERPROJECT

6.1.3

Timescale Zones

Powerproject has a similar function to SureTrak Zoomed Timescale.

>
>
>

SureTrak has the ability to create one Zoomed zone.
MSP only displays one timescale.
Powerproject may create up to three separate Timescale Zones with different time

scales:

2005

Jan | Feb | Mar April (T T (A 1510 N
[ L A1 s |28 L
1 3 5 | 7 | ] | L] | 10 11 19 127 135
1 1 1 1 L] [ 1

10 TR T
[
,

BN e e IF [ A
) R TR

6.2 Formatting the Timescale

All formatting is accessed by right clicking on the timescale

The timescale may be dragged like SureTrak to expand or contract the timescale

Up to 10 Timescale Lines may be displayed, they are added or removed by right
clicking on the timescale.

Up to three timescale zones may be created.

Grids (Gridlines) are formatted here.

Shading may be added here.

Folding exceptions hides the nonwork time and is accessed from the General tab, any

checked Exceptions will not be displayed on the bar chart.
Date Zone Properties

] Dates.-’ScaIes] Gridzs ] Shading]
Folding calendar T Sy | 5 | N
e ime Uni Lar. ..
[ Defout =] o | e
Check to fold out of view Marith
[ Al nonworking Week Start
Elapzed Units Elapsed Week 1
Mon 'working Unused
[] Holiday Unused s
[ Owertime J
Weskend Backgrou... | Tick Marks | Text |
Cloge | Cancel | |
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6.3 Bars

The bar chart is formatted by selecting Format, Bar Chart or Right Clicking in the Bar
Chart.

Format Bar Chart (Bar Chart View - Wilson International B... EE|

Tasks Allocations l Progress] Non-Working] VerticaIScaIe] At Height] Lirks ] Baselines] General]

Appearance Show Fesources and Costs

" From task v Demand ﬁf( Diefault
v Scheduled

" From type default W Costs

" From fibrary m

Type default appearance
Unszatisfied demand (| Schedulad (|
Satisfied demand (| Cast (|

[ Sart allocations by name in WES

Close | Cancel

6.4 Tables & Columns

Columns are held in a Table and Table may be displayed in a View in the same way as
Microsoft Project.
» Columns may be added and removed from a Table like Microsoft Project by right
clicking on a column header.
» Select View, Table; where tables may be saved, edited and selected for display etc in
the same ways as Microsoft project.

? Asta Powerproject - [Bar chart - Wrexham Park Development (F

File Edit [Yiew | Insert Format Tools Hierarchy Window Hel
i P
O | ] view vl . . [Ty AW - | 7R
|E Table Ty ..
. E & & FEilter ¢ Properties..,
A Sort » Save As...
Task ~ Link - il Mew Histogram Marme, Duration Start (Default Table)
= Qgﬁﬂﬁl‘f w Close Histogram Planned v Actual Progress - Slippage
- Root || v | Plot Mo, Hopse Type, Start, Dur & End
= L | Y| Histogram Wiew
T F'_ ] gt Vi Plot o, Hclﬂsﬂ, Type, Start, Dur, End, %, Planned %
= roject View
Bl _]— Flat Ma, Name
=l F Toolbars » Plot Mo, Marme & Linked Docs
B Refresh view FS Plot Ko, Mame , Start, Duration S End
+ 1=
+ % Consi £001M.., Plot Mo, Sale Price & Costs
+-Ll Cosk Centres T
+ {57 Code Libraries + . M‘?re Tahles:" —
+-[q] Calendars #éﬁ
+ Progress Periods |
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6.5 Filters

Filters are edited, created and saved using View, Filters in the same way as Microsoft

Project.

Ctl Clicking on node in the Project View selects only the details tasks of each node and acts

as a filter and is quick and simple to use.

6.6 Sorting

Sorting is applied using View, Sort.

To create bands for Crews etc select View, Sort and generate a sort as per the pictures

below:

Sort Properties for Crew & Project

Detals Bars / Tasks | Permanent RBS | Consumable RES | CBS |

Sort by
| Type | Direckion | Field | Sub head. .. | Sub heading fonk | Sub hea
1 Task Azcending  Crew Ird Arial-12  [Eyan
2 Task Ascending  Project Mame ™2 Arial-12 o
« | 2
= eat | | | |

Sort Properties for Crew & Project

Detail: Bars / Tasks l Permanent RES ] Consumable RBS ] CBES ]
Sort by
| Sub heading colour | Ruling lire | Retain hierarchy | Hi... | Page bre:

1 [cyan | r 7

2 [welow | —— I r

Kl | O

- s | | |

QK. | Cancel |
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6.7 Views

Views are more similar to Microsoft Project than SureTrak Layouts. More than one view

may be displayed at a time and they may be Ctl tabbed from one to another.

A View contains:

>

YV V V V

Table

Bar Chart formatting
Timescale formatting
Sorting

Filters

Histograms and other data
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7 ADDING LOGIC & CONSTRAINTS

7.1 Link Category

Links may be assigned a category and link categories may be switched off. For example
Sequencing Logic may be entered into a schedule to level the resources. Then these
relationships switched off and the resource levelling function used. Link Categories are
created in the Library Explorer view and assigned in the Link Properties form which is

opened by right clicking on the link and selecting Properties:

Link Properties for Task 3-E... [2 [X]

Details | Link Start | Link End |

Attributes

Link type Finizh-to-Start [F5)

Mornal
Resource

Annotate lead/la
Curvature

Draw curved if vertical [ =

LCurvature percentage 3

Reschedule flags
Critical v Driving ¥
Unschedulable [~ Onloop [
Comments

=

7.1.1 Links may be entered by:
» Dragging, the relationship is end sensitive like SureTrak and all type FS, SS, SF &
FF may be put in by dragging. The Picture below shows the shape of the cursor

required to add a relationship:

» If the relationship is dragged half way along a successor a Lead or Lag may be
assigned with out having to open a form and typing it in.

» Select multiple tasks or bars and then select the create link button on the Bar
chart toolbar. Like SureTrak it will not link in the order they are clicked on (as in
Microsoft Project) and the chain linking is from top to bottom (as with Primavera

products).

30
Eastwood Harris



CONVERTING TO ASTA POWERPROJECT

7.1.2 Editing relationships

» Right click on the link and select Properties and this is where the Start and End lag

are edited:
Link Properties for Task 3-E...

Tazk Tazk 3
Bar Tazk 3
Chart path
WBS pathname 44.51

Dates

Lead/Lag attributes

Lag lvpe Tirme

“Summan 2

Start date 2/07/2007 5:00 PM

Lead/Lag 0d

Link Properties for Task 3-E... El@

Task Expanded Task
Bar Expanded Task
Chait path
‘WwBS pathname 44.53

“Summany 2

Dates
End date 3/07/2007 8:00 AM
Lead/Lag attributes
e e
Lead/Lag ’Udi

Leac

Close

Close

7.1.3 Viewing relationships

» Right Click on Bar and select Properties

» Display the appropriate column

7.1.4

Logic may be deleted by:

» Selecting graphically & when green right click and select Delete or hit the delete

button.

7.1.5

» Select Edit, Link From/To...

manually.

Adding and Reviewing Links Manually

to open the Link From/To form to add links

» Select a task bar and select Edit Properties or right click in the Bar Chart and select

Properties, click on the Links tab to see the links. Ensure you select the bar in the

bar chart.
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7.2 Constraints

Constraints may be added by:
» Right Click on the task and select Constraint Flag and select the constraint, or

» Show appropriate columns
» Select the tasks and click on the Constraint button on the Task toolbar:
» Asta Powerproject - [Bar Chart View - Wil

5
kS

Bl S5
e 3

— Q Wilson International Bid

= (B Root chart
= Q O=zBuild Bid

Research
Estimate
Fraposal

— m Cost Centras

i Default

- L=.' E,:u:-de Libraries
L:i‘ Default Librans

— m Calendars
L= P

e
W,
H
o

0 Eile Edit Yiew Insert Format Tools Hierarchy WAindow He

9 -0 - A€
EE Days | N
Start On or After
Start On Marme
Finish On ar Before
Wiork bebwesn
Deadline st Dioe
Eemove

i

» The task may be dragged to the appropriate date and the constraint applied
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8 SCHEDULING

To schedule the project:
» Press F9 or

» Click on the schedule button 2 accept the defaults and the project will schedule.

The Tools, Options... Reschedule tab sets some of the scheduling calculation parameters:

X

Options for Safelink Alliance

Tasks with no links
(" Leave as drawn within constraints

{* Move if at project or chart bounds
" Move to ASAPAALAP position

Compatibility
™ Momnal critical behasviour

[ Einish on or before flags are soft

lgnore link categories

[]Default
[lImportant
[CIMarmal
[ R esounce

Edit ] Wiew ] Format] Progress  Rescheduls ] File Locations] Ealendars] Spreadsheet] Genelal]

Tasks with only outgoing links
" Leave as drawn within constraints
* Move to ASAPALLAR position

Options

v Move part completed links

[ Truncate float within chart boundaries
[~ Belink around completed tasks

Straighten prograss line to period
| Progress entry period ﬂ

[ Orly rowe Fonsard to make steaight

Close
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9 CREATING AND ASSIGNING RESOURCES

9.1 Creating Resources

Resources are created in the Library Explorer and there are two types:
e Permanent Resources which are intended to represent your labour, crews and
equipment, and
e Consumable Resources which are intended to represent the materials consumed by
the project.
Resources may be assigned a Rate which enable multiple resources to have their rate

changed by changing the value of a rate assigned to multiple resources.

Resources may be assigned a colour and pattern which is displayed in Histograms.

9.2 Assigning Resources

Resources are assigned by:
e Select one of more tasks in the Gantt chart and drag from the Library Explorer,
e Open the Bar and Task Properties form by right clicking in the Gantt chart and

selecting Properties, then clicking on the Allocations tab:

Bar and Task Properties for Stage 1

Bar ] Tazk Allocations ] Links ] Helations]

Allocatable Mame | Type | Allocation | Amount Total Amount Dane Amount Rern:
2, (Bricks Consu  1,000.00 100000 0.00 10
&] Architects Perma 1.00 24h Ok

|§ Assign Permanent Resource Crane
g Assign Consumable Resource 4 Design Resources  #
f:‘lg 4 Services Engineers Services Engineers
ﬂ-‘( Assign Cosk 4 all resources » | E——
Show Permanent Allocations L@Ectricians
Show Consumable Allocations Fitters
Show Cost Allocations Plumnbers

Show dllacation Group Allocations

Show Only Resources

Show Only Costs

Show Fields. ..

KN I 2
== Wariance. . Less << | Cloze |
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9.3 Viewing Resource Assignments

Resource assignments may be viewed in a number of ways:

9.3.1 Resources as Bars

To view resource lines under each Bar name and as bars under each Task in the Gantt chart:
e Open the Format Bar Chart form,
e Select the Allocations tab,

e Select For resource under the Appearance tab.

Juby 03
Line Mame Fredecessors | Successors Constraint Duration | Fn[20 21 (22 23 24 | 25 | 26 | 27 | 28 | 4
Moy T W T F 5 5 | M | T,

+ 1| Start Sitewarks Format Bar Chart ( 1 Logic - Test Schedule {090720-06 .pp) \Ballarat Road)
* 2 BRIEREGEEIEREE § ~E3ES Tasks Allocations l F‘mgressl Non—Wolking] Wertical Scale] Auta He\ghtl Links ] Baselines} General]
+ 3| Ballarat Road Temporary Services 1-4

4 Temporary Line App Show Fietowces and Costs
+ 5| Install Temp Services 1-4 " From task ™ Demand E R =

i Forwai Crew * [From resourcel [+ Scheduled 3EEPN 16

7| eld Strings 1 (BYY) " From type default I~ Costs gg EE
+ 8| Install Infrastopidalve Contral 1-4 " From Jibrary <Mones < B3FE

] Crews
* 9| Water Off 1-4 Type default appearance Office
* 10| Pipe BurstPrep 1 Unsatisfied demand | I Scheduled || + Flant
i Subcontract

+|_ 11] ConstrustPipe Burst1 Salified demand | NN Cost —— T —

iz Breaker 38 Tonne porat -

13 Crew unassigned ™ Sor allocations by name in WES

T4 T23 PN 2.3
w18 weld1 (EF)

5 (el ISEEE) Close Cancel Apply
+ 17| Connections 1
9.3.2 Resource Histograms

Create a histogram by:

e View, New Histogram,

e Edit the two boxes at the top left hand side of each histogram to select the required
data.

e Multiple resources may be selected for a histogram:

8 Breaker 50 Torne, Break: = il Alocation to Date i

B B W gl

2 | 8 PolywelderBw), Infrasto = il Allocation to Date -

LT

0

3 | 8 Temporany Line

= [l Allocation to Date b

B B W 0

2,000- —:

1,000-

0-

4 | 8 Crew Hayden

- [l Alocation to Date @

B B W W

T —

05—

0.0- E
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9.3.3 Resource Columns

Resource data may be displayed in columns for one or more resource by formatting one or
more columns in the Table Definitions Properties form:

Table Definition Properties

Column Definitions l
Teem | Appearance
Line Title |Subcontacars ‘wiord wrap I
Mame
itle: i Blank for subheads v
Resources alosations Title align |Eentre j Elark for subheads
Resources allocations Cell align |F|ight j Zero as blank v
Resources allocations » Wwidth |23.DD Apply wiew filer v
Rezources allocations Detail
Resources allocations -
Data |L|ve j
Dates | e | S
Specific task Settings ... |N0 settings
Attributes
Cons/Perm |Permanent Fesources j
Resource |B‘ Subcontractors ﬂ
Scheduled/Demand |Scheduled Allocations j
Rolled/Direct |Rolled Up Values |
Show tokens Primary hd
+ U = Add
4 Down ¥ Femove Editing the private copy of the table definition that iz stored in pour view.
Cloze | Cancel Apply

Line Mame Crew Flant Subcontracors | Temp Line Fipe
1 TEMPLATE 2.00 1.00 200.00 | 125 PN 12.5 394.00
2| Start Siteworks
3 Wield Strings BWY
4| [Enter Street Mame] Temparar 20000
5| Install Temp Services 1.00
6| Install Infrastopfdalve Cantral
T Water Off
8| Connections 1
9| Pipe Burst Frep 1

10 Caonstruct Pipe Burst 1 1.00 1.00 126 FM12.5197.00
11| wWeld EF 1.00

12| Connect\Water Services 1 1.00

13 Charge &Test

14 Remaove Infrastop 1.00 1.00 126 PM12.9197.00
16| FRemove Temporary Semvices 1.00

16 Restoration 1.00

17| Finish Siteworks

9.3.4 Resource Table

Your should be able to create a Resource Table.
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10 SCHEDULING

To schedule the project:
» Press F9 or

» Click on the schedule button 2

accept the defaults and the project will schedule.

The Tools, Options... Reschedule tab sets some of the scheduling calculation parameters:

Reschedule

Options l Scopel

Tasks with no links

" Leave as drawn within constraints
7 Move if at project or chart bounds
& Move to ASAPAALAP positior

Compatibility

[ ALAP tasks have no free float

[ Firizh on or before flags are soft

[ Summaries critical where cantent iz
[ Megative loat applies to chain

Ignore link categones

[ D efault
[ Important
[C1Marmal
[C1Resource

Tasks with only outgoing links
" Leave as drawn within constraints
' Move bo ASAPAALAP position

Options

v Move part completed links

[ Truncate foat within chart boundaries
[ Belirk around completed tazks

Staighten progress line to periad

| Progress entry period ﬂ

[ Orly move foraard to make straight

Reschedule report

Settings ... Digplay

(14 | Cancel

Scheduling Report may be turned on or off here.
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11 PRINTING

11.1 Concepts

A printout has a border file which defines the static information on a printout such as titles,

logos and paper output and orientation. The default files are saved in the Border

subdirectory.

11.2 Setting the Software to Print

The print defaults need to be set before successful printing may take place.

>
>
>

YV V V V

Select Print, Preview

Select the Border File, say CHT-A3L.B which is an A3 Landscape file

Select the Printer Properties from the Print from, use the Print Settings button.
Set the paper size and orientation to be the same as the Border file.

Select the Appearance tab and uncheck Font scaling.

Close the form.

Select One Page or Multiple pages as required.

Click on other icons as required or select Print Settings and check the remainder
of the settings.
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12 PRINTING

12.1 Concepts

A printout has a border file which defines the static information on a printout such as titles,

logos and paper output and orientation. The default files are saved in the Border

subdirectory.

12.2 Setting the Software to Print

The print defaults need to be set before successful printing may take place.

>
>
>

YV V V V

Select Print, Preview

Select the Border File, say CHT-A3L.B which is an A3 Landscape file

Select the Printer Properties from the Print from, use the Print Settings button.
Set the paper size and orientation to be the same as the Border file.

Select the Appearance tab and uncheck Font scaling.

Close the form.

Select One Page or Multiple pages as required.

Click on other icons as required or select Print Settings and check the remainder
of the settings.
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13 SETTING A BASELINE

A baseline may be set for:
e A project, or
e Selected Tasks

Select File, Baseline/What If Manger.... The process is wizard driven and self explanatory.

13.1 Create the Baseline

> Select File, Baseline/What if Manager...

Select New

Follow the Wizard & Apply

Select Format, Bar Chart, Baseline tab and select the baseline you wish to display.
Turn of the Critical Path by selecting Format, Bar Chart..., Task tab and uncheck

>
>
>
>

Critical.
* Asta Powerproject - [Bar Chart View - Wilson International Bid (OzBuild 11.pp) ]
: File Edit Yiew Insert Format Tools Hierarchy ‘Window Help = il
M DL B aby | Bl Dy (A gort Primavera P3| flImpart Brimavera P3
H% Baseline/What If Manager (Wilson International Bid) U A - ©Task - Link - Allocation ~ Bar Chart - Cost Allocations -

=4 [ Hame {00 [Crested [ Updated | Deleted | Cument [ Import.. [ Reverting™  Mew.. |h L . - — =
Baselne 1 13047200, 13/04/200. Vg o L January L shaiary L arcl I

2

= @ F 12 i3 @6
et T EO T i I
Set s Curent | G
Rsvert To
< i | & Impot.

- Details - Revert Opti
Pathname IE Y_DatatSoftware\Asta Power ProjectWistra DocshOzBuild ©

I1

' Hestore deleted objects

Description " Festore deleted and changed chjects

" Restore selected objects

€ Deenuic i
Hppearance| —| |- | (—
Tasks | Alocations | Progiess | Norwiorking | Vertical Scale | Auto Height | Links ~ Baselines | General | |
+ 8B Supplier Component Bids
Check o show tasks for Check to show sllacations for I~ Show progress period fines
o [ Project Schedule [ DS otwarstista Power [0 DatatScftwareiasta Power - [cHanes ~]
+ 10 Technical Specification
M Component Bids Costs
<D 3 | ¥ e >
# A% Proposal — b —! L) — = l ==
+ 13 Draft Bid Docurnent % hs set in baseline manager I~ Always show new baselines
L an R aviewad Draf Bid Documant s set by cument task or 1ssource: ™ Show basslines on their own ines
+ 15 Cesign Validation
+ 1B Revised Bid Dacument
T Component Packages Close I Cancel Apply
Negotiated T | T T e e
I — 24
(000 v | 4@ @ | ef 12122008 v~ B | 17d | T4 2009 = T | O (Mone) -
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13.2 Displaying Baseline Data
To display the Baseline:

e Baseline bars are displayed by right clicking in the select Format, Bar Chart and

select the Baselines tab.

Format Bar, Chart (Bar. Chart View - Untitled (demo 07.pp) )

Check to show allocations for...

[]bla bl [<Nones -l

[]second

I >
Appearance
+ Az zetin bazeline manager ™ Always show new baselines
" Az zet by curent task or resource ™ Show bazelines on their own lines
Cloze | Cancel | Apply |

e Baseline data may be displayed in columns by changing the Detail Data:

Table Definition Properties

Colurnn Defiritions l
Telem | Appearance
Line Title |BL End wiord wrap I
Unigue Task D . "
- v
Name Title align |Eentre J Blank for subheads v
Start Cell align |F|ight j Zero as blank v
Durstion Width |23.00 r
End Detail
End 7 "
Data | Current Baseling j
Dates | J To | J
Specific task Settings ... |N0 settings
Attributes
Show tokens Frimary hd
+ Up = Add
¥ BRemove Editing the private copy of the table definition that iz stored in your view.
Cloze | Cancel Apply
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14 PROGRESSING A SCHEDULE

Steps are:
» Save a new file for this update
Collect status data, not covered in the document
Set the progress report date
Enter progress and changes
Reschedule

Show variances

YV V V V

14.1 File naming Convention

It is suggested that a new file is saved every day using the “yymmdd Infratec Projects

Schedule” naming convention and is the same date as the current progress period.:

E.g. a file names “090721 Infratec Projects Schedule.pp” is a schedule update on the 21 July
2009 at 17:00.

14.2 Set the progress report date

There are two options for setting the progress date/s in Powerproject.
» A single Report Date may be set, or
» A number of Report Dates may be set up at the start of the project and each one used

in turn as the schedule is progressed.

At Intratec one Report Date is going to be used and changed when the schedule is updated
each day. This will be at 17:00 each day.

To change the Report Date and Time open the Progress Properties form, say by right

clicking on the Progress Periods in Library Explorer.

14.3 Enter progress

To enter progress:
e Apply the Progressing View
e Completed activities have the
o Actual Start and time set, and
o Actual Finish date and time set.
e In-progress activities have the:
o Actual Start and time set,

o Duration Remaining
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o % Complete
o Apply a Start Constraint if there is going to be a delay to the
recommencement of the task.

o Add new scope etc.

If you do not want to see the bars being split then remove the Split progress sections check
from the Format Bar Chart form:

Format Bar Chart (Bar Chart View - Untitled (demo 07.pp) )

Tasks ] Allocations  Progress l Non-\-\-"orking] Yertical Scale] Auta Height] Links ] Baselines] General]

Lines Shading Line style
¥ On " DK % Jagged [draw to task progress)
Progress Periods ™ Black (™ Straight [draw to report date]
Project Report Date f* Caloured
Drawing i
= Al -
" Completed

" Uncompleted

Close | Cancel Apply

14.4 Reschedule

Press F9 to reschedule and run reports.

14.5 Completed Projects

It is suggested that once a project is complete it should be deleted from the Asta
Powerproject file.
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